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ABSTRACT

The resources required for the initial developme nt of a website for a private school with
limited financial resources prevents many of these scho ols from reaping the benefit s of
this technology. This project researches schools’ needs for websites and develops proto-
type software of a low-cost website generation tool that may be used b y the faculty of
these schools to generate their web sites. The functionality of this prototype is tested by

potential users in terms of quality and simplicity with promising results.
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EXECUTIVE SUMMARY

The internet has become an import ant resource for gathering and distributing in-
formation. It can be used as a way to commu nicate with many people in a very easy
and efficient manner, however, if one lacks the knowledge of how to use the technology
it can be a difficult and frustrating experience. The internet, or the World Wide Web, in
particular, is a very useful technology for schools. Many universities, such as WPI, have
a wide variety of administrative an d academic information available t hrough the Web.
This allows students to access information directly related to courses t hey are t aking,
activities during the we ek, or sports schedules, very easily at any ti me. These schools
have invested thousands of dollars in setting up and maintaining these resources, which
could drive up cost s for students or require funding from the governme nt. Similarly at
the high school level and below , the web is still a highly valuable reso urce, and many
schools invest in the technology necessary to make use o f the web fo r academic pur-
poses. Public schools can use pub lic funds for developing a web site to keep students
and parents informed of school a ctivities, athletics, etc. as well as providing acade mic
resources such as course information, class schedules, and anything else that students
may want to access both at school and at home. Some private schools lack such great
resources, however, and so they d on’t always have the ne cessary funds for such tech-
nology, which can limit their competitiveness in the academic arena. Religious sch ools
in particular, which might receive little or no public funds, often run on tight budgets that
make developing and maintaining an acade mic and ad ministrative website fo r their
school something that can’t be done very effectively. The concept implemented in this
project as an automated website generator explores the possibility of such schools being
able to easily create feature rich web sites which provide quality communication between
the school, parents, and student s. The software is design ed and test ed to be easily
used by any teacher or st aff person who may have limited knowledge of internet t ech-

nology.



1. INTRODUCTION

The World Wide Web is one facet of the vast information network we call the internet.
Sometimes called the information superhighway, the internet is an evo Iving technology,
constantly changing, molded to de liver information faster and more ef ficiently. While

there are many method s of accessing information via the internet, the web is one of the

most commonly used to day. This is likely due to the fact that a graphical web browser
interface is very user-friendly , with a point-and-click operation that does not requir e
knowing all sorts of co mmands which other int ernet portals such a s telnet and g opher
use. As aresult of the popularity of the web, there has bee n a plethora of information
created for the web in the web standard Hypertext Markup Language (HTML), as well as
electronic copies of pre-internet in formation, stored on servers world wide and made

available to anyone with the tools necessary to access it.

One of the advantages of the web as an information resource is its global nature.
Anyone with web access can get in formation from any web server in the world at any
time, and in many cases free of charge. It is like having a n enormous public library on
one’s desk that is open all day, every day of the week. In fact, some public libraries, and
other libraries as well, have web sites allowing access to online resources both d uring
and outside of their operating hours. But the information on the web reaches far beyond
what a library can contain, as any co mputer connected to the internet can act as a web

server, delivering information about anything to anyone who requests it.

This freedom of information access and distribution raises many issues, however,
not the least of which is the issue of information security. A reputable web site requires
some sort of security to protect it s information from alteration by anyo ne not authorized
to make ch anges to the content on the site. There are many threat s to comput er sys-
tems open to the public, such as any computer connected to the internet. Malicious us-
ers both physically present at the computer or using another computer anywhere else in
the world connected to the internet can and do try to cause harm to co mputer systems,
be it distrib uting a virus, defacing a website, or destroying information. Good security
can prevent most of the se intrusions, but the hardware an d software required for such
protection is usually prohibitively expensive fo r an individual to invest in. However , an
individual usually does not have th e need for their own we b server. This is why most

personal web sites are on shared servers where a comp  any owns the hardware and



software for serving the web sites, and rent s space to individuals or other comp anies.
This makes efficient use of their systems, as well as makes it affordable for many people

to have their own web presence.

There are drawbacks to these shared server s, however. They are generally re-
strictive in regards to how much information and what types of information can be stored.
They often require the user to have knowledge of HTML or at least have software capa-
ble of gene rating HTML p ages, although many do of fer very simple web site cr eation
tools. The main problem with such tools is the limitations they place on what a user can
do and what technologies they can use in their web sites. Because of all the limitations
of shared servers, man y organizations choose to operate their own servers for serving
their web sites, which all ows much flexibility and creativity, but at the cost of purchasing
and maint aining equip ment, as well as employing sof tware developers to creat e and

maintain the web sites.

The commercial advantages to having product and service information available
on the web are obvious: it is one more advertising venue in which the company can in-
vest. Most, if not all, large commercial organizations own and operate their own web
servers in order to guarantee the security of their information, as well as to have the flex-
ibility of deciding what equipment is necessary and upgrading when necessary. There
are many other advantages as well, all of which are aimed at increasin g the company’s
profit. Many non-profit organizations also inve st in their own servers for similar reasons.
Charitable organizations ma y use t heir web presence to advertise to increase aware-
ness for their cause. Academic organizations may recruit students and inform alumni of
news and events. Organizations of all types and sizes have staked a claim to space on
the web to allow them to share information of a Il sorts with the rest of the world across

the internet.

The web is a very useful technology for schools. It is an immense resource for gathering
information, and for distributing inf ormation. Many uni versities, such as WPI, have a

wide variety of academic information available through the W eb as well as other less
common internet protocols such as Telnet. This allows stu dents to access in formation
directly related to courses they are taking, or plan to take, very easily at any time. These
schools hav e invested thousands o r millions of dollars in setting up a nd maintaining
these resources, but this can be offset by increasing the cost of tuition, or, for public uni-

versities, obtaining more public fund s. Similarly at the high school level and below, the



web is still a highly valuable resource, and many schools invest in the technology neces-
sary to mak e use of the web for a cademic purposes. Public scho ols can use public
funds for developing a web site to keep studen ts and parents informed of school a ctivi-
ties, athletics, etc. as well as provid ing academic resources such as course information,
class schedules, and anything else that students may want to access both at school and
at home. The schools may even be able to share hardware, software, and development
resources with the local govern ment to defray these cost s. Pri vate schools, however,
don’t always have the necessary f unds for su ch technolo gy, and this of ten limits their
competitiveness in the academic arena. Religious schools in particular, which might re-
ceive little or no public funds, often run on tight budgets that make developing and main-
taining an academic website fort heir school difficult to justify . Renting sp ace on a
shared server is on e inexpensive option, but does not ad dress the cost of develo ping
and maintaining the website, which normally re quires at le ast one per son working full
time. An a dditional e mployee, e specially with the skills required for developing and
maintaining a website, is a major expense for a limited budget. This usually means that
the school either has a very limite d, poorly maint ained website, or does without com-
pletely. Of course a school does n ot need to have a website, but if the cost could be

brought within reach of the budget limitations, the advantages are tremendous.

There are several ways in which the cost of a website can be reduced. One is to reduce
the size and/or complexity of the sit e, and therefore reduce the time needed to develop
and maintain the site. This results in both lower development costs and lower mainten-
ance costs, but at the e xpense of greatly diminishing the utility of the website. Another
alternative would be to utilize one of the many “user-friendly” web devel opment tools on
the market t oday, so that an out side consultant or additional faculty me mber would not
have to be brought in to do the development and maintenance. These tools include pro-
grams like Microsoft FrontPage, Macromedia Dreamweaver, and other similar products.
While these programs allow a high degree of flexibility and advanced features to create

a highly functional website, they still require a substantial knowledge of web technology
to create such a website. These products are also quite expensive for just a single copy
(approximately $149.99 for FrontPa ge, $319.99 for Drea mweaver) [1], so with a limited

budget a school could probably only af ford to buy one copy of the sof tware, if it could

even afford that, and so all website development and maintenance would be limited to a
single computer on whi ch the sof tware was installed. These two optio ns place sig nifi-

cant limits on the utility of the website or the cost and ease of use of the website. Ideally,
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there would be an alternative that would be inexpensive and yet still allow the creation of
a robust website that will enable a school to t ake full advantage of web technology. This
solution would also allow maintenance to be performed not just at one computer with the
special software installed, but from any computer with access to the website. This is the

type of solution proposed by this project.

In order to demonstrate the deman d for a solution such as described in this re-
port, we created a survey to get feedback from schools. In this survey we asked wheth-
er the scho ol had a website, what features the y would like to have on a website, and
whether they would use a product which allow ed them to i mplement such features. We
distributed this survey to 49 Christian schools t hroughout the US based on a directory of

Christian schools found at http://www.acsi.org [2]. The responses we received are de-

tailed in Appendix B, and the graphs below in Figures 1, 2, and 3 summarize that data.

Number of Requested Features

45 -
41 41
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30 | 29

25 24

21 22
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Figure 1 — Number of Requested Features
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Number of "Yes" Responses

"Yes" responses per category
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Figure 2 — Yes Responses per Category
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Section

Figure 3 — Yes Responses per Section Heading
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Of the schools which re sponded, 60% already have websites, but 67% of these
were interested in the ability to add features and functionality to their website, as our so-
lution would allow them to do. Afew expressed a desire for specific features which their
current solution could not accommodate, or perhaps could only accommodate at a p ro-
hibitively expensive cost. The other 40% of schools did not have websites and were in-
terested in developing one, and they also like d the ideas we proposed. From the
enthusiastic responses we concluded that there was a strong desire for a highly fle xible

yet easy-to-use and inexpensive website development and maintenance solution.
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2. BACKGROUND INFORMATION

2.1 Web Sites Today

Web sites today have evolved from the early text-only pages into complex docu-
ments using graphics a nd scripting to create an aesthetically pleasing site that can de-
liver the ne cessary information to the user as quickly as p ossible. A good website is
easy to navigate, providing an obvious p ath to the information a user wants. Often web
sites make use of databases to index the information available on the site so that a user
can search for their desired information quickly and easily . Increasingly sites use these
databases not only for a search feat ure, but also for storing the information in a hig hly
organized fashion, which allows the web server to make use of technologies such as Ac-
tive Server Pages (ASP), Java Server Pages (JSP), CGl script s, or other dat abase re-
trieval technologies to dynamically c reate web p ages with the information stored in the
database. This allows the display of information the user r equests, as well as other po-
tentially related information that may be of use to the user. Because the emerging tech-
nologies ba sed around the Extensible Marku p Languag e (XML) are found in  both
databases and web bro wsers, the merging of t hese two is becoming much more com-
mon. XML is related to HTML in that they are both markup languages, but XML is much

more flexible and can be easily adapted to many applications.

The use of databases to store data for a web site makes sense, as a database is
designed to store data, and a web site is design ed to deliver information. It can also be
much more user-friendly on the developer side to only have to update the database to
change information on the web site. This avoids the need to go throug h many lines of
HTML code to find where the information needs to be changed, and if the information is
on several different pages, repeating the process for all pages can be very tedious. One
simple change to the database updates all the p ages on which that infor mation is used.
This allows those who are unfamiliar with HTML and other web technologies to make the
necessary changes so that web de velopers can have more time to incorporate new fea-

tures into the web site.

Security becomes an even greater i ssue when dealing with databases, however,
because not only do the web pages need to be secured from unauthorized modification,

but the dat abase also has to be secured. At the samet ime users must be abl e to
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access the information freely, and t hose authorized to make changes must be able to
make any changes they need to make. These issues usually are much more significant
for larger, high profile web sites that are more likely targets for hackers, but still must be

kept in mind by all web site operators.

2.2 Christian Schools

Today, more than ever, there is a n eed for an or ganization to have a strong web
presence. This need is felt, even by schools, as the number of familie s with comp uters
increases and the World Wide W eb becomes the most prominent source of information
for these families. Schools, private Christian schools in particular, often don’t have the
resources or the means by which t o create a “web-presence” and are therefore f alling
behind in this technolog y-centered society. These schools, while they of ten cannot af -
ford the expenses to create a feature rich website, would benefit immensely from the use
of one. A feature-rich web site might provide such information as a calendar of events,
class assignments, bulletin boards, school information, and notices of school cancella-
tions or other important news. The cost to cre ate such a website that allows up-to-date
information can of ten be overwhelming to these schoo Is. Other cost s which can also
inhibit the use of a feature-rich up-to-date website are t he maintenance and te chnical
support fees which can be very high as well.  Therefore, it would be beneficial to t hese
schools to have a program which would enable them to generate a co mplete web site
that has all the advantages of a professionally made site without requiring any program-

ming experience; one that would allow the web site to be easily maintained.

These schools would p articularly benefit from the type of p rogram prop osed by
this project. As explained earlier, the use of a d atabase as the information storage me-
chanism removes the need for a web developer for updatin g the content of the web site.
The program would also offer a flexible structure with many options, allowing the school
to choose a ppropriate themes for their schoo |. By handling the navigation menus dy-
namically through the database, the web site is guaranteed to have exc ellent navigation
and allow quick and easy access to the information any user may want to see. Addition-
ally, the ability to add and remove features gives a school the option of future expansion,
or the option of remo ving a feature should they find the y no longer have a need for it.
This ease of use and flexibility both speed up and simplify the creation and management

process, as well as allowing any of the school facu Ity and administ rators to m ake
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changes to the portions of the web site to which they have access. By distributing the

management load, it becomes simple to set up and maintain a good, robust web site.

2.3 School Websites

There have been several government al initiatives at the f ederal, state and lo cal
levels throughout the US for tec  hnology funds for education. These represen t an

enormous government investment in using technology to improve education. Many such

funds are o utlined at http://www.ed.gov/Technology/tec-quid.html [3]. Below is ju st one

except demonstrating the size of the technology investment:
Technology Literacy Challenge Fund

A five-year, $2 billion fund to provide formula grant s to state edu-
cation agencies to support grassroots efforts at the state and local
level to meet the four national techn ology goals for schools: mod -
ern computers, high quality educational software, trained teachers,
and affordable connections to the Internet. After the Technology Li-
teracy Challenge Fund was launched in FY97 and funded at $200
million, it more than doubled with $425 million appropriated in
FY98. These funds are awarded to all 50 states and outlying areas
according to the ESEA Title | formu la. The challenge fund is de-
signed to encourage states, local communities, the private sector,
schools and individuals to work together to integrate technology

into teaching and learning.

Of course, most of these funds go into equipment purchases and not into the de-
velopment and maintenance of websites for schools, but the substantial amounts availa-
ble dedicated exclusively for technology purposes allows for some funds to go to aweb
development initiative. | n addition to these fed eral funds, many state and local govern-
ments have similar programs for supplement al funds for technology investment s. Be-
cause of the disparity in tax revenue and cost of technology deployment, poorer school
districts tend to have | ess opportu nity for technology deve lopment than more wealthy

districts, but there is at least some funding dedicated for technology programs.

For private schools, t here is a similar disp arity between poor and wealthy , but

there is no governmental equalizer to funnel funds to the schools with smaller budgets.
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Private schools, p articularly religiou sly affiliated private sch ools, usually get some in-

come from tuition payments and some from charitable donations from alumni or commu-
nity members. Thus, if these schools want to invest in te chnology, the funds need to
come from one of the se sources. For ex ample, some schools have numerous distin-
guished and wealthy alumni who ha ve contributed very sub stantial funds for a wide va-
riety of pur poses, some of which involve technology investment. As aresu It th ese
schools are able to afford faculty and staff members who work full-time on development
and maintenance of an extensive website. On the other hand, a less fortunate school

may get very little in donations, forcing either little or no te chnology investment, or an
increase in tuition costs, which the ir students may not be able to afford. Cert ainly a
small school with only a few faculty members could hardly af ford the sub stantial invest-
ment in an additional st aff member to handle the t asks of website development and
maintenance. Someone with such high-tech training would likely command a significant-
ly higher salary than the average teacher ’s salary. Consequently, such schools tend to
lag behind other schools, both public and private , in utilizing new technology. To enable
them to make effective use of web technology, a high-quality, low-cost solution is neces-

sary, and can be achieved by developing a solution which targets that specific need.
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3. METHODOLOGY

A straightforward methodology was used to realize this project. First, we identified
the problem. We did this by composing a series of survey questions that we then sent to
49 private Christian schools throughout the United States in October 2000. Ten schools
sent completed surveys back to us. The survey mostly asked what features a school
would want on their website, if they currently have a website, and if they would like to be
able to easily and d ynamically update the content on their site. W e also researched the
current state of a doze n schools by visiting their websites. W e came to the conclusion
that many schools have very basic and content-poor sites, or no sites at all. A reason for
this was that the schools couldn’t a fford the large amount s of money re quired to pay a
company to build a website for them, which, as of Ma y 2000, would cost anywhere from
$113,500 to $608,000 [4].

Next, we devised a so lution to the problem. The solution was to b uild a software
program, EDUwebMaker, that would generate the complex web sites needed by to day’s
school, yet require only very limited technical skill, and also be two orders of magnit ude
cheaper than having a professional build the web site. In fact, the software would do all
the work, so the price co uld be set to whatever profit was required by the comp any sell-
ing EDUwe bMaker. Even if the sof tware cost a couple thousand dollars, the resulting
website would be two orders of magnitude cheaper than having a company design it for
you. Not only will this solution be cheaper, but it will also have the ability to offer the web
pages that many schoo Is mentioned they woul d like on th e survey. We determined we
would make a prototype, sort of a proof of concept, of our solution. This would allow us
to test the feasibility of the idea. This would allow us to focus on the idea of the solution,

and not on many of the details that come with making a finished product.

The specifications, particularly the software specifications, were then developed for
the program we had determined wo uld solve the problem. These specified exactly what
the software needed to do, so that at the end, we could determine whether we had met
our goals or not. From the specif ications, the software was actually built. Additionally,

the support files needed by EDUwebMaker were also create to specification.

At this point, testing began. First there was function-level testing, where individual

functions in the software were teste d to insure they performed as expected. Secon dly,
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functionality testing was performed t o see if the software met specifications. Many soft-

ware bugs were found in these first two stages that required significant time to correct.

Finally, user testing wa s performed. The sof tware prototype was used by two
school employees, who tested it and commen ted on the concept of t he software pro-
gram. Basically, they were testing the usefuln ess of the sof tware. The quality of the
website generated was then comp ared to th e quality of a website  which would be

created by a professional website developer, and the prices were also compared.

In the end, the work was documented. This is especially important, since we only
created a prototype. This software could be marketed, jud ging from our feedback, but
that would require more developme nt, something that would have to be done at a la ter

date. From our documentation, others should be able to continue where we stopped.
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4. EDUwebMaker

4.1 Overview

The website generator created by the authors, known as EDUweb Maker, is the
technical pr oof of con cept that sho ws how the idea of a dynamic we bsite gener ation
program could be constructed. The goal of EDUwebMaker was to create a program that
would contain all the features of a full-fledged school web site generator; however, the
program would not inclu de all the options that a full program would co ntain, and it also
wouldn’t be tested to the same level of quality as a final product. This is what makes it a
proof of con cept. It proves that the concept would work; cr eating a final solution from

this proof of concept would be straightforward, albeit time-consuming.

EDUwebMaker is a sof tware program that the user installs onto their computer .
When the program is executed, it allows the user to create a completely dynamic school
web site based on Hyp erText Markup Language (HTML), Active Server Pages (ASP),

QE BRI e ,_J _J d

File Help

D|(u| =] 2| <[>
Welcome to EDUwebMaker

Welcome . Ifyou would like to load a project you were previously
wiorking on, go to the File menu and select Ooen.

To start a new project, Qo to the Fife menu and select New. Select
a location and a name of your project. The program will create a
Froject File with all yvour selected options. When you generate
your weh site, itwill get placed in a sub-directory from the location
Yol selected.

Mext, a preferences window will pop up (you get always get back

to this window later by going to the Fie menu and selecting
Praperties). On the first page you can set basic information about
the site, like the name of the project and the name of the school. _

Onthe second page you can select the security model for the wieb
site. This is an important step. One of the features of your web
site will be that you can update the content from any browser.
However, to make sure unauthorized people don't change your
web site, you must set up accounts for everyone that is allowed to
edit yourweb site. Then you can select what pages each user can
edit. Users may also be organized into groups. For example, you

C:\Program FileshE DU webb akershtmihwelzone. hin 16:33 4/19/2002

Figure 4 — Screen shot of EDUwebMaker program
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and Open DataBase Connectivity (ODBC). It output s the web site as a series of files in
a given directory. These files can then be uploaded to any web server running Microsoft
Internet Information Server®© (IIS) to allow the web site to be accessed from anyone with
access to the World Wide Web (WWW). EDUwebMaker will be designed to work on any
Windows 95 or later based computer. A screen shot of the EDUwebMaker program can

be seen in Figure 1.

An overview of how a session of using EDUwebMaker might go is as follows. Af-
ter installing EDUweb Maker using the setup program included on the CD, the user ex-
ecutes the installed program. The user selects to create a new project and then sets the
project folder. This is the location where the generated files (that need to be uploaded to
the server) will be placed. Next the user enters some basic information about the project
(for example, the name of the school), and then describes the desired security model (or
picks from some predefined ones).  The security model defines the u ser names and
passwords for each person who will have access right s to modify the web site. This se-
curity model can, of course, be upd ated later. An indefinite number of group s of u sers
can be placed in the se curity model. A screen shot of the Properties win dow that allows
the user to define a security model is shown in Figure 2. In the figure, there are two

groups, Teachers and Administration. As an example, Teachers w ould hold a Il the

Figure 5 — Screen shot of Properties window

B Guiius %]

General Info 5

v Usze predefined security model: Model 1 ﬂ
Groups Uzers
Teacher
Administration Teacher2

Pazzword for Teachers |

Ok, | Cancel |
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teachers as individual user. Administration would hold users who would have access to

B3 Oytiuns a

Select features: Freview:

This is the Home FPage

| calendar
hiarne

histony

objectives i e o e e

principalmessage e et e e o o e o

about

directions
w| facultudic

philosophy

Impartant Anmeancement!!

Ol A el P

1 b s e, el i

Dezcription:

Alternate Home Page

Select startup page:

Lawout | Mavigation | Stle  Features | Effects |

{-Back ‘ MHest - | Finizh ‘ Cancel ‘

Figure 6 — Screen shot of Options window

higher-level sections of the website.

Next, the user select s the options for the web site. This includes the layout, na-
vigation, style, features and effects. The layout describe s the general layout of all the
web pages (where the navigation bar is locate d, etc.). Na vigation lets the user select
which navigation bar st yle they wo uld like. S tyle selects the look and feel of the web
site, including the colors, backgrounds, and icons. Features selects what web pages will
be included in the site. Finally, effects selects any special effects you would like on your
site (and is limited only by the creativity of the p rogrammer). For example, it could dis-

play a special message to the user if it recognizes the person viewing the website.

Next, the user selects to generate the web site. The web site is generated, a de-
fault database is created, and the files are all placed in the given directory and are ready
to upload to the server. However, before uploading them the user can test the web site.
This displays the web site in the project window exactly as the user will see it. Not only
does this allow the user to check that the web site looks ok, but it also allows them to go
through the administration pages to enter the data that should be initially on the web site.

The administration pages are available to anyone that can get to the web site. However,
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a user name and p assword are required, and are stored in the dat abase. The adminis-
tration pages allow the data on each web p age in the web site to be updated. The up-
dated data goes in the dat abase. At this point, the user uploads the files to the web

server, and the web site is up and running!

- EDDWeblakereitie

File Generator Help

(@l ] 9] <]

C:A\Program Files\E D Uwebkakerasp-local htm CAPS | 0243 | 4/24/2002 |

Figure 7 — Sample Home Page

In Figure 4, a sample web page is shown, as displayed by EDUwebMaker after it
has generated the website. The fact that the navigation bar is on the lef tand is sur-
rounded by green is determined by the “layout” choice. The style of the navigation bar,
like the fact that it is vertical and has arrows pointing at the current page, is determined
by the “navbar” choice. The background texture and the styles and colors of the fonts
are determined by the “ style” choice. The actual layout of the current page, and the in-
formation on it, is deter mined by the “feature” choice. Notice also that at the bot tom of
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the page is a link to the administration section of website, where administrators can up-

date the content on the website.

4.2 Features

EDUwebMaker contains many impo rtant features that will be described below

First, it is very powerful. It can ge nerate a dynamic website that is served it s dynamic
information through a database. The data on the site can b e customized depending on
the time or who is looking at the sit e, for example. By using a dat abase, data to be dis-
played on the web site can easily be stored and retrieved. EDUweb Maker is also flexi-
ble, both fro m a user ’s point of vie w and a pr ogrammer’s. In th is context, the u ser is
defined as the person at the school who generates the we b page, and the progra mmer
is the person who designs the pages that the user can select (typically, the programmer
would work for the company that sells EDUwebMaker). The user can change everything
from the style to the layout to the contents to the security model used. The programmer,
on the other hand, can easily add “plug-in” modules that e  xpand the o ptions the u ser
gets. Adding options becomes very straight forward. Other benefit of EDUwebMaker is
it's ease of use. Even though it creates web sites that would normally take a profession-
al web developer half a dozen months to develop, it should be able to be used by some-
one with ve ry limited te chnical knowledge. Finally , the program creat es secure web

sites; that is, websites t hat cannot easily be modified by th e wrong people. This atten-
tion to se curity allows t he web site to be updated from any web browser by dif ferent
people, where each person has their own user name an d p assword that givet hem

access to a certain part of the site.

4.2.1. Power

EDUwebMaker supports ASP, a way to make dynamic web p ages (i.e. web pag-
es with cont ent that changes depen ding on the current time or the current user). ASP
can read data from a database and then display that data on the screen. EDUwebMaker
can do just about anything that ASP can do. It uses ASP to get it s information from a
Microsoft JET database, which is the dat abase technology used in Microsof t Access.

The database is create d when the web site is generated, and can the n be update d by
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the administrators as they make changes to the web site. A user browsing the web sit e
sees the data that is cu rrently in the dat abase, thorugh the web page. This allows the
information on the web site to be d ynamic, not static. For example, one could have a
calendar of events. A table in the database would be created, when the web site is gen-
erated, for the calendar of events. An administrator could then access the online admin-
istration pages and tell them to add a new event. This new event would be placed in the
database. When a user then goes to view the calendar web page, the user gets the data

currently in the database, and so sees the updated calendar of events.

A second useful feature of ASP that EDUwebMaker uses is the ability to present
information that meet cert ain conditions at certain times. For example, a calend ar web
page might only display event s for the current month, or an announce ment on an an -
nouncement page might only be displayed ont he web site for a week. Being able to
schedule when information will be displayed makes it much easier for those people
maintaining the web site. They can schedule when information will be available, and

then forget about it.

Afinal u seful feature o f ASP utilized by EDUwebMaker is the ability to display
different information to dif ferent users. This is primarily useful for the security aspect,
mentioned below, where each administrator only has access to a certain part of the site
depending on their user name and password. This feature could also be used by users
of the web site, though. For example, students could be given user names and pass-

words that would allow them to see their grades.

4.2.2 Flexibility

EDUwebMaker is very flexible. All the options (layout, navigation, style, features
and effects) are all independent of each other and can be mi  xed and matched in any
way. Any amount of det ail can be easily added to each w eb page template by the pro-

grammer. This will give the user as much control as possible over each page.

Although this is the most obvious benefit to the user , the more import ant benefit
may be the flexibility to the programmer. All the options that the user can select are ex-
tensible by the programmer. For example, all that’s needed for the programmer to add a
new layout is to create a new ASP file and the n reference the new file in the dat abase.

The programmer needs not have access to the original source code for EDUweb Maker.
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A second advantage to this is the ease of creating add-ons to the software. Someone,
for example, could make their own set of styles, layouts, features, etc. available as add-

ons to the original software. These could then be sold as upgrades to the user.

4.2.3 Ease of Use

EDUwebMaker is easy to use. The user need not know h ow the tech nologies
behind the program wo rk. They don’t even n eed to know HT ML. Itis possible for
someone with very little technical knowledge to design the layout of the website and add
the data to be displayed on it. The user must only know what they want the layout of the

web site to be, and the data they want displayed on it.

All the tech nical details are hidden behind the interface. The user is p resented
with the web-site design level, not the coding level. They choose how the web site looks
from a list of options, which p ages they want on the site from a list of options, and t hen
proceed to enter the data into the database via web-based forms. Someone familiar with
the WWW should be able to design a web site using EDUwebMaker.

4.2.4 Security

One important feature is security. It is imperative that unwa nted persons cannot
modify the generated web site. This is a very real concern since th e administration of
the web site is offered through the web site. The administrator logs on to the adminis-
tration section of the web site using a user name and password. Administrators are then
presented with a list of options they can modify. What they have access to is determined
by their login name and p assword. Wit hout this user name and p assword, someone

can’t make any modifications to the web site.

The security model is set up as follows. There is a main, built-in administration
account, called admin. This account has a defa ult password of admin, something that
should be changed immediately. The admin account has complete access to everything:
all the web pages, and complete access to cha nge the security model, including chang-
ing passwords, and add ing and removing group s and users. The admin account is the
only default account. That account can be used to add more accounts later, or they can

be specified in the security settings when a project is first created.
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Groups and users can be created. For example, a Teachers group could be
created, and then each teacher could get a user account within the Teachers group. A
group account has per missions to certain web p ages, which are inher ited by the user
accounts within a group account. A group account also has a password. Someone can
log in using the group name and password, and then make changes to the membership

of the group.

Users can be added to groups, in which ca se they inherit the permissions of the
group they are in; they can be given addition  al permissions, as well. Users ca n be

created outside of groups, as well. And example of a security model is as follows:

admin - default account; permissions to all pages and all users

Teachers - group account containing all teachers; permissions to the Teach-

er's Overview page and all users in the Teachers’ group

--- Fred - user account for one of the teachers; permissions to the Teach-

er's Overview page and Fred’s personal page

--- Mary - user account for one of the teachers; permissions to the Teach-

er's Overview page and Mary’s personal page

Secretary - user acco unt (not in a group) for the school secretary; permis-

sions to all the general school information pages

4.3 Working Prototype

As stated before, the number of options in EDUwebMaker is very small, though
all features are demonostrated; only enough options are provided to prove that it wo rks.
This is what is currently there. There is a simple inst allation program that installs EDU-
webMaker and components required to make it run on t he given operating syst em (it
supports all Windows-based machines). Also included is a readme file for basic installa-

tion and execution instructions.

The program itself comes with some basic options to  show the poten tial of the
EDUwebMaker program. The main part of the screen is an HTML browser. This is use-
ful for previewing the web site you are creating, but it also allows conte xt-sensitive help

to be given in the form of HTML pages while you are creating the site. The program pro-
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vides help to the user for each step in the process of creating the web site. Additionally,

some additional help can be accessed via the “Help” menu.

The program let s you create, ope n, and modify “project s”. A project is a set of
the options that a user specified for a website, along with all the generated files fo rit.
Once you create a new project, you may select the options for the web site. Here are
the basic options that show of f the power of EDUwebMaker. In a full product, there
would be many more o ptions, and much more detail for each one. Under Layout, you
select the basic layout of the web pages on the web site. There are only two available in
this proof of concept software: navigation bar on the left or on the top. Under Navigation
bar style, you may select various sty les of navigation bars for your site. There are cur-
rently four simple ones. Under style, you set the look and fe el (colors, graphics, etc.) of

the web site. Four simple schemes are provided to show what could be done.

There are ten sample web pages under Features. Each of these becomes one
web page in the web site. “home”, “home2”, and “calend ar” are complex p ages with
highly customizable content. The other seven pages are simple, just displaying informa-
tion about the school. “home” and “home2” are two possible home p ages, with home2
being the more compl ex of the two.  The u ser can se lect which p age is the startup
(home) page by selecting it from the drop-down list at th e bottom of the window . The
calendar page displays a three-month calendar with events listed on th e day that t hey
occur. Note that the calendar is time-sensitive, displaying the current month a nd the
next two months. “History” displays a page that includes the history of the school. “Ob-
jectives” displays a list of goals that the school has. “Principalmessage” displays a mes-
sage from the princip al of the school. “Abo  ut” list s inf ormation a bout the school.
“Directions” provides directions to g et to the school. “Facultydir’ list s the names and e-

mail addresses of the faculty. “Philosophy” displays the philosophy of the school.

Finally, the user may select any e ffects you want on your web site. The current
choices are “none” or “Status Bar”. The status bar option scrolls a welcome message in
the form “W elcome to <school nam e>!" at the bottom of every web page. Effects are
written in JavaScript and can be as complex and creative as the programmer of the ef -

fects wants them to be.

Also included are basic administration pages for each web p age you can select.
They let the user insert and modify all the information displayed on that page. The user

interface isn’t very prett y for the ad ministration pages, but they get the job done. Ina
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final implement ation of this progra m, the administration p ages could be made much
more aesthetic and user-friendly. An example of an administration page is shown in Fig-
ure 5.

gia Ly Dby - Tl

File Generator Help

SRR

C:\Program FileshE DU webb akersasplocal htm CAPS | 0%E7T | 4/2402002 él
e ; ; ; — - ; - ; P —

Figure 8 — Sample Administration Page

4.4 Program Architecture

EDUwebMaker was written as a Microsof t Visual Basic 6.0 applic ation. It relies
on three D ynamic Link Libraries (DLL): MyASP  .dIl, MyASP2.dll, and MyCo mp.dIl.
MyASP.dll is written in C++, and the other two dII’s are written in VB. They are based on

public-domain DLLs found on Microsoft’s web site ( http://www.microsoft.com). The pro-

gram also relies on the following Microsoft-provided components (that are automatically
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installed if they don’t already exist when y ou install EDUwebMaker): Visual Basic con-
trols, MS Int ernet Controls, MS ActiveX Data Objects (ADO) 2.5 Library , MS Scripting,
MS Script Control 1.0, and MS HTML Object Library.

The EDUwebMaker VB project consists of the following component s; note that all these

files may be found on th e CD that accomp anies this report in the “Sour ce Code” su bdi-

rectory:
Global Modules:

Module1.bas:

Class Modules:
CAspParser.cls:
Security.cls:
Groups.cls:

CGroup s.cls:
Users.cls:
CUsers.cls:

cProjinfo.cls:

Features.cls:

Forms:
frmS plash.frm:

frmMain.frm:

frmProperti es:

Contains st artup code, global su broutines, an d global va -

riables and constants.

Class that converts an ASP to HTML client-side.
Class that defines the security model of the project.
Class that contains a list of CGroups.

Class that defines the security of a group of users.
Class that contains a list of CUsers.

Class that defines the security of a user.

Class that defines all t he information about a project. Also

serializes this information (saves and loads it from disk).

Class that defines the features in a project. Part of cProjlnfo.

Splash screen that shows up while the program is loading.

Main form. Contains the main user interface via menus and

the HTML browser in the main part of the window.

Allows the user to insert general information about their

project and define the security model.
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frmFeature s: Allows the user to choose the features they  want for th eir

web site.

frmAbout: Gives information about the EDUwebMaker program.

All these files contain VB code. Comments are used throughout the code. Each
function is commented on what it does and how it interacts with other functions. In addi-
tion, there are comments within fun ction to describe what exactly they are doing. See

the source code on the CD to get an idea of how the program works.

In addition to the VB pr oject, there are supporting files that are require d for the
project to work. First there is the setup.mdb database. This is a JET database. It has a
table for each of the types of features for a web site (ef fects, features, layouts, navbars,
and styles). In each table, each entry defines one feature that will be list ed in the EDU-
webMaker program. Each entry also defines w here the file s for the feature are located
relative to the program directory. This database makes the EDUwebMaker program eas-
ily expandable (see below). A diagram of the structure of the database can be seen in

Figure 6.

Next are the generic file s that are used to build the final web site. These are lo-
cated in the /data directory. In general, each feature is defined by one or a few files un-
der the dat a directory. These files are all independent of each other . This allows a
programmer to add a new feature merely by creating a new file or two, and then entering
their locations in the setup.mdb. Each type of feature (effects, features, layout s, nav-

bars, and styles) is located in its corresponding subdirectory.

There are some general file s located under the data directory. aspstart.inc and
aspend.inc are generic include files that are in cluded at th e beginning and end of the
ASP pages. They contain ASP commands to open the database and extract some gen-
eral information from it. content.mdb is another JET database. It contains all the infor-
mation for the website. It starts off blank. When a user creates a project, it is populated
with project-specific data. In its “blank” state, it contains one table for each feature that
the program supports, and default data for that web p age. After the user generates the
web site, they may use the administration section of the we b site to add and modify the
information that ends up in this dat abase. Next, the security.txt file co ntains the defini-

tions of the security models that may be selecte d by the user when sett ing up a project.
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Finally, the  xbrowser.js file is a JavaScriptinclude file that get sin cluded
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setup.mdb

o ef fects
" name
= description
= samplepic
= filename

o features
" name
= description
= samplepic
= filename
= level
= simpleadmin
= unique

e layout s
* name
= description
= samplepic
= filename

e navbars
" name
= description
= samplepic
= filename

e sty les
" name
= description
= samplepic
= cssfi le
= backfile
= dividerfile

Figure 9 — Structure of Setup.mdb Database
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with the web pages. It causes some variables to be set to the current browser version

and platform. It makes it easier for web pages to be cross-browser/platform compatible.

The files un der the admin directory are the basic files for implementin g the ad-
ministration section of the web site. There are various include files that are included in
all the administration pages. authorize.inc makes sure the user has logged on, in order
to keep the administration section secure. convert.inc contains an encoding and decod-
ing function that replace s a newline (carriage return/line feed) character with the HTML
<br />. It also replaces double quotes with sin gle quotes. This allows the programt o
display the text as it will appear to the user, without any HTML codes. The default.inc file
contains the code necessary to ope n the database. Finally, footer.inc contains informa-

tion that will be displayed at the bottom of each page.

There are numerous ASP pages under the admin directory a well.  default.asp
merely redirects the user to login.asp. login.asp allows the user to log in. It lets them log
in with a username and p assword, and verifies it with the database. main.asp is the
main page. Depending on the user’s username, it d isplays whatever options tha t user
has. accounts.asp an d accountsadmin.asp allow a user to modify login account S.
password.asp and updatepassword.asp let a user change a their p assword. startup.asp
changes th e default st artup p age for the web site.  general.asp let’s the user modify
some basic properties t hat affects the whole web site. The main p age also links to all
the web p ages the user has admin istration rights too. These pages are defined under

features\admin.

The files under features are divided into two subdirectories: admin and asp. Ad-
min contains ASP pages ( *.asp) that are the administration pages for each feature (one
page per feature). The ASP page is responsible for letting the user add, edit, and delete
information for the given page. It retrieves and stores the information in the content.mdb
file. Under the asp directory are located include files, one for each feature (web page).
Each one contains the HTML and ASP code necessary for the bulk of each page. They

access the database to get the information displayed on them.

The files un der effects are include files (*.inc) that contain JavaScript code that
will give the web site a special effect. The files under layouts are ASP files that define
the layout of all the pages in the web site. They contain the basic stru cture of the web
page. They automatically include th e aspstart.inc and aspend.inc files, the content file

(from the features\asp directory mentioned ab ove), and the navigation bar (mentioned
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below), along with vario us values from the da tabase. The navbars directory contains
include files, one for e ach navigation bar style. They contain the HTML and ASP code
necessary to display a navigation bar that will list and link to all the w eb pages in the
web site. F inally, the styles directory contains all the files n ecessary to define how the

web pages look. There are three s ubdirectories. backgrounds contains JPG gra phic
files for each of the supported background for the web site. dividers contains GIF graph-
ic files for e ach of the supported divider graphics for the web site. Fin ally, stylesheets
contains CSS (cascadin g style sheet) files for e ach style for the web site.  These files
describe the appearance of the we b site, everything from font color and size to back-

ground image.

The final directory under the data directory is the thumbnails directory. It contains
JPG images that are displayed in the program when the user is selecting web site prop-
erties. Each image gives a preview of what s electing that option will cause the web site
to look like. For example, when the user clicks a feature, a sample of that web p age is

displayed. When a user clicks a navigation bar, a sample of it is displayed.

The final supporting files for the program are located in the himl/ directory. These
are various HTML files that contain help to the user on how to create a web site with the
program. They can be viewed by going using the “Help” menu in the program, and are

automatically displayed when necessary when working with the program.

Finally, installation files are built from all the p rogram and data files so that the
user may inst all the pro gram on their system. The installation project and code were
written in V isual Studio .NET and were generated automatically froma code “wizard”.
Along with the inst allation project are a co uple support files. The autorun.inffilei s
placed in th e root directory of the CD where the final installation files are placed. This
file tells a computer that has AutoRun enabled which program to launch when the CD is
put in the drive. It instructs the computer to run the installation program. Secondly, there
is a readme.txt file. This ReadMe file cont ains all the infor mation on how to inst all and
run EDUwebMaker. It is installed with the program and placed in the root directory of the
CD.

As you may see, there is a lot of complexity involved with this project. Not only is
there the code for the actual program to worry about, but there is HTML and ASP code in
dozens of support files, all referencing a dyna mically-generated database that must be

assembled together perfectly. However, in the end, handlin g all the co mplexity on the
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programmer’s end allows us to present a program that is simple for the user . The user

has the power to create very complex web sites with minimal effort and complexity.

=l L} SourceCode
= ) ASPZHTML
+ ) MyASP
+ ) MyAsPz
+ ) My Comp
=l |Z) EDUwebMaker
=l | data
Iy admin
I effects
=l |} Features
=) admin
) asp
I lawouks
I navbars
= |y styles
[ backarounds
[ dividers
I skylesheets
I thumbnails
=l ) html
) help
+ ) Install

Figure 10 — Directory Structure of the EDUwebMaker

Source Files
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5. RESULTS

As mentioned before, o ur project was tested at three levels: function, functional,
and user. At the most basic level, individual functions in the software were tested for
functionality. This included checking algorithms such as the ones in the classes to make
sure the object s performed their desired funct ion. Many bugs were found during this

phase and corrected.

The project was also tested at the functionality level. Here, the sof tware was
tested to see how well the specified requirements, listed in section 4, were met. Basical-
ly, the software had to work as designed. The installation was tested on different operat-
ing systems and was found to work on Microsof t Windows2000 and later; however , it
was a little quirky on e arlier operating systems. Otherwise, it performe d all its required
functions adequately, including being able to cr eate, save, and close p rojects, generate

web sites, view those web sites after creation, and allow the user to administer them.

Finally, the project underwent user testing. Since we knew our sof tware proto-
type now worked, it was time to see if it achieved it s more qualitative goals. Those
would be p ower, flexibility, ease of use, and security. To perform the user testing, we
were able t o0 demonstrate our sof tware, specifically the a ctual progra m and not such
things as the installation or the overall unfinishe d look, to two school employees and get
their feedback. The two employees were Carol White, a S pecial Education Assistant at
Hampstead Middle School in Hampstead, NH, and Lynne Croswell, a Substitute Teacher
on the Boar d of Directo rs at Christ ian Heritage School in Trumbull, CT. Here ar e the

questions asked and their responses after they tested the software.

1. Do you think that there would b e someone at m ost schools who co uld run our pro-

gram and generate a website?

Mrs. White: Yes, most schools have a technology person who keeps the computer sys-

tems running. They would easily be able to do the initial set up of this software.
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Mrs. Croswell: A small school may not have the tech support as far as staff designation
but could hire a consultant if someone in-house did not have the cap ability to generate
the site. With today's te chnological climate it is hard to imagine that th ere would be no

one who could do this, even if it was a parent.

2. Do you think that the average teacher could ad minister the web site once it has been

generated?

Mrs. White: Yes, though it would b e helpful if the technolo gy person would run an in-
service training session so everyone is familiar with what th e software can and cannot
do. Teachers might have to be periodically reminded to keep their web site up-to-dat e

with current information.

Mrs. Croswell: | am uncertain about the capabilities of the "average teacher" but | think
that certainly one who i s competent in basic computer skills could ad minister the site

once it is created.

3. Could th e web sites generated by this prog ram satisfy the needs for a school web

site?

Mrs. White: Absolutely, though it would be nice if pictures could easily be added to the

web site. Also, being able to e-mail the school with questions is a nice plus.

Mrs. Croswell: | would think so. Did you have a feature that would allow the adminis-
trator to create and format custom pages or would they only be able to choose from your

options?

4. What features did you like about the program?
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Mrs. White: When setting up the web site the choices were limited. If one is given too
many creative options, one can get bogged down in trying to make it look nice and there-
fore, it becomes too time consumin g to be upd ated on a re gular basis. The web pages
offered were clear and easy to read and under stand once the information had bee n en-

tered onto them.

Mrs. Croswell: | like the fact that the site can be accessed through any internet connec-

tion, rather than one main computer or a school network computer.

5. What features did you dislike about the program?

Mrs. White: | found th e explanations about ho w to set up the web site to be too long

and complicated. The directions need to be simplified for the non-technical person.

Mrs. Croswell: | would love to see the design options you would include and ways to
give the sight a personal look. (I think the Christian Heritage School site | mention ed at
the top is pretty bare-bones and not terribly cre ative and appealing. P erhaps that is the

norm though and | expect too much.)

6. The program gave you a choice of what kinds of web pages you wanted on your web
site (e.g. calendar page, home page, faculty directory page, etc.). What additional kinds

of web pages do you think would be useful for the program to be able to generate?

Mrs. White: A page for sports/chorus/play etc practices. The regular calendar would

get too crowded with all those dates. Perhaps each dept. might want their own calendar

page.

Mrs. Croswell: | would love to see pages for t he lunch menu, fine art samples which
could also include text as to who did the work, student of the month/ outstanding student

feature, spo rts schedule and reco rd update, alumni, out standing fa culty recog nition/
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achievement, and volun teer opportunities and/or recognition. These are what | thou ght

of off the top of my head.
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6. ANALYSIS OF RESULTS

We received response s from both of the teachers who tested the software.
Overall, the responses were pretty favorable and supported the need and usefulness of
a the type o f product this prototype demonstrates. Since the sof tware is just a pro of of
concept or a prototype there was limited functionality and features but enough to test

anyway. An analysis of the answers is below.

Both teachers thought that at most schools there would be somebody, perhaps a
parent at worst, who would be cap able of inst alling and setting up the sof tware. Mrs.
Croswell suggested that possibly a school could bring in a consultant to at least set up
the software, but they b oth said that the school should have someone e xperienced with
computers especially nowadays wi th computers being so import ant in daily life. Also,
they both a greed that as long as a teacher had basic co mputer skills and possibly a
short in-service training session on how to use the software, it would be quick and easy
for one to update and administer one’ s portion of the website. Again, the teachers were
in agreement that the EDUweb Maker could generate a website which was feature rich
and useful so that it would satisfy the needs of the school. A feature wch Mrs. W hite
liked was the limited choices in customizing the look of a particular page to keep things
simple and uncomplicated. Botht eachers like d being ab le to administer the we bsite
from any co mputer in the world with a connection to the in  ternet. The features which
they didn’t like were the rather long and complicated explanations and the lack of options
for customization to personalize a schools website. These features, of course, would be
incorporated in a finished version of the software, perhaps as another project, and not in
this prototype. Other types of p ages in the website which the program doesn’t currently
incorporate and the teachers would like to see include, separate pages for sports, cho-
rus, and p lay practices t o keep t he main calendar page uncluttered, fin e arts samples,
lunch menus, out standing stude nt features, alumni, volunteer opportunities and
achievement recognition pages. Since the scho ol would likely have a st aff member ca-
pable of operating the software or could at least have a parent help out, the cost of using
this program would only include th e hosting fees from an internet service provider which
can range from $200 to $1200 per year [4]. The benefit to cost ratio would be very good.
However, hiring a design firm to make a quality site for a school would severely lower the

benefit to cost ratio. A high quality website which costs $1000 or less because of a host-
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ing fee is much better than a high quality website which costs thousands of dollars just to

develop and maintain then even more to host the website as well.
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7. CONCLUSIONS AND RECOMMENDATIONS

Through the course of this project we determined a need for an inexpensiuve and
easy way t o create fe ature rich a nd useful w ebsites for schools wit hout resources to
make one using current methods. The EduWebMaker prototype demo nstrates some of
the functionality and usefulness of a program which would aid in making such a w ebsite.
After having the sof tware tested by some teachers and analyzing the feedback which
they provided, we have found the software to be useful to schools for providing a simple
to use development platform through which a feature rich and effective web presence for
a school can be created and administered. By making use of this program a school can
have an effective way of communicating betw een teachers, students, parents, and out -
siders. Some recommendations for future work would include adding more features and
customization options since the prototype is ra ther bare-bones in its current state. With
some more time and effort (i.e. a company making it into a finished product) this unique
program could be made very powerful and extremely useful to schools without resources
for much computer technology and even possibly to schools which already employ tech-

nology experts.
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APPENDICES

Appendix A — Survey of Schools

e Do you currently have a web page for your school?

e Ifyou were going to create a web site for your school, which of the following fea-

tures would you want to include on it?

U Message on homepage if school is delayed, canceled, etc.
U General Info
u Objectives
Philosophy
History
School facts
Tuition
Financial Aid
School songs, etc.
Student Handbook/rules
Directions
Maps

Other

News

o O 0O 0 0 0O 0 000D o O

Message from the principal

-44 -



o 0o oo gyboooggbo bbb o o o

News items

Archive of news items

Other

Calendar (different formats)
Students
Directory
Optional home page link
Parents
Alumni
News
Reunions
Faculty (teachers and administration)
Directory
Bio
Home page link
Class links
Teacher of the year

Other

Academics
Curriculum
Class descriptions
Course handbook

Divided into K, 1-6, Jr High, High School
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Other

Areas: Science, art, etc.
Courses
Info
Description
Course web page

Summer programs

Athletics

Other

News

Calendar

Schedule

Scores

Coaches

Individual Sports
Team rosters
Coaches
Scores

Schedule

Activities

Other

Clubs/Organizations (info web page or custom web page link)

Community Service
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Facilities/Services
Library
Link to card catalog
Computers
Computer use policy
Guidance
College Guidance

Other

a
a
a
a
a
a
a
a
U Publications

a Newsletter

a Current
a Archive
a Yearbook

U Other

U Community links
U Links
O Site index

U Additional “custom” web pages can be added at any level

e What additional features would you want on the site?

e Would you create/update a web site for your school if you could have any of the

features mentioned in this survey on the site?
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e Would you like information in the future about this project when it is completed?

Thank you for filling out the survey. Please return it in the enclosed envelop.
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Appendix B — Results of Survey

Academics:

ID Curriculum Cla ssDesc Cou rseHandbook Courses CourseWebPage Summer

0 TRUE FALSE FALSE FALSE FALSE
1 TRUE TRUE TRUE TRUE FALSE
2F ALSE FALSE FALSE FALSE TRUE
5 TRUE FALSE FALSE TRUE FALSE
6 TRUE TRUE TRUE TRUE TRUE
7F ALSE FALSE FALSE FALSE FALSE
8 TRUE TRUE TRUE TRUE FALSE
9 TRUE TRUE TRUE TRUE TRUE
10 TRUE TRUE TRUE TRUE TRUE
7 5 5 6
Activities:
ID Club s CommServ Other OtherVal
0 FALSE TRUE F ALSE
1 TRUE TRUE FALSE
2F ALSE FALSE FALSE
5 TRUE TRUE FALSE
6 TRUE TRUE FALSE
7F ALSE FALSE FALSE
8 FALSE TRUE F ALSE
9 TRUE TRUE FALSE
10 TRUE TRUE FALSE
5 7 0
Athletics:
IDNe ws Calendar Schedule Scores Coaches Individual
0 TRUE TRUE TRUE TRUE TRUE FALSE
1 TRUE TRUE TRUE TRUE TRUE TRUE
2 TRUE TRUE TRUE TRUE TRUE TRUE
5 TRUE TRUE TRUE TRUE FALSE TRUE
6 TRUE TRUE TRUE TRUE TRUE TRUE
7 FALSE FALSE F ALSE F ALSE F ALSE F ALSE
8 TRUE TRUE TRUE TRUE TRUE FALSE
9 TRUE TRUE TRUE TRUE TRUE TRUE
10 TRUE TRUE TRUE TRUE TRUE TRUE
8 8 8 8 7 6
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Other
TRUE FALSE
FALSE FALSE
FALSE FALSE
FALSE FALSE
TRUE TRUE
FALSE FALSE
FALSE FALSE
TRUE FALSE
TRUE FALSE
4 4 1
IndRosters Other
TRUE FALSE
FALSE FALSE
TRUE FALSE
FALSE FALSE
FALSE FALSE
FALSE F ALSE
TRUE FALSE
TRUE FALSE
TRUE FALSE
5 0

OtherVal

OtherVal



Alumni:

ID Ne WS
OF ALSE
1 TRUE

2 TRUE

5 TRUE

6 TRUE
7F ALSE
8 TRUE
9 TRUE

10 TRUE

Facilities:

ID Libra ry

Faculty:

ID Dire ctory
0OF ALSE
1 TRUE

2 TRUE

5 TRUE

6 TRUE

7F ALSE
8 TRUE

9 TRUE

10 TRUE

Alumni can e-mail their addresses and e-mail addresses to

Guidance CollegeGuidance Other

Reunion  Other OtherVal
FALSE FALSE
TRUE FALSE
TRUE TRUE  alumni email addresses
TRUE FALSE
TRUE TRUE  school
FALSE FALSE
TRUE FALSE
TRUE TRUE
TRUE FALSE
7 3
LibLinks Comps CUP
FALSEF ALSEF ALSE FALSE
TRUE TRUE TRUE TRUE
TRUE TRUE TRUE TRUE
FALSE TRUE FALSE TRUE
TRUE TRUE TRUE TRUE
FALSEF ALSEF ALSE FALSE
FALSEF ALSEF ALSE FALSE
TRUE TRUE TRUE TRUE
FALSE TRUE TRUE TRUE
46 5 6
Bio Homepage ClassLinks TOY
TRUE FALSE TRUE FALSE
TRUE TRUE TRUE FALSE
FALSE TRUE TRUE FALSE
FALSE FALSE FALSE FALSE
TRUE TRUE TRUE FALSE
FALSE FALSE FALSE FALSE
FALSE FALSE FALSE TRUE
TRUE FALSE FALSE FALSE
FALSE FALSE TRUE TRUE
4 3 5 2
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FALSE
TRUE
TRUE
TRUE
TRUE
FALSE
FALSE
TRUE
TRUE

Other

FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
0

FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
60

OtherVal

OtherVal



General Info:

ResponselD Objectives Philosophy History Fact s Tuition
0 TRUE TRUE FALSE TRUE TRUE
1 TRUE TRUE FALSE TRUE TRUE
2 TRUE TRUE TRUE TRUE FALSE
5F ALSE TRUE TRUE TRUE FALSE
6 TRUE TRUE TRUE TRUE TRUE
7 FALSE FALSE FALSEF ALSEF ALSE
8 TRUE TRUE TRUE TRUE FALSE
9 TRUE TRUE TRUE TRUE TRUE
10 TRUE TRUE TRUE TRUE TRUE
7 8 6 8 5
Aid Songs Handbook Directions Maps Other
TRUE FALSE TRUE TRUE FALSEF ALSE
FALSE TRUE TRUE FALSE TRUEF  ALSE
FALSEF ALSE FALSE TRUE TRUE FALSE
FALSE FALSEF ALSE FALSE FALSE F ALSE
TRUEF ALSE TRUE TRUE TRUE FALSE
FALSE FALSEF ALSE FALSE FALSEF ALSE
FALSEF ALSE TRUE TRUE TRUE FALSE
TRUEF ALSE TRUE TRUE TRUE FALSE
TRUE TRUE TRUE TRUE TRUEF  ALSE
42 6 6 6
News:
ResponselD Message News Ar chive  Other O therVal
0 TRUE TRUE FALSE  FALSE
1F ALSE TRUE TRUE FALSE
2 TRUE TRUE FALSE  FALSE
5F ALSE TRUE FALSE FALSE
6 F ALSE TRUE TRUE FALSE
7F ALSE FALSE FALSE FALSE
8F ALSE FALSE FALSE FALSE
9 TRUE TRUE TRUE FALSE
10 TRUE TRUE TRUE FALSE
4 7 4 0
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Publications:

ResponselD Ne wsletter NewsCurr NewsArchive Yearbook Other OtherVal
0 TRUE TRUE TRUE FALSE FALSE
Student News-
1 TRUE TRUE TRUE TRUE FALSE paper
2F ALSE TRUE FALSE FALSE FALSE
5 TRUE TRUE FALSE FALSE FALSE
6 TRUE TRUE TRUE FALSE FALSE
7F ALSE FALSE FALSE FALSE FALSE
8F ALSE FALSE FALSE FALSE FALSE
9 TRUE TRUE TRUE FALSE FALSE
10 TRUE TRUE TRUE FALSE FALSE
6 7 5 1 0

Students:

ResponselD Dire ctory Homepage Other OtherVal
0OF ALSE FALSE FALSE
1F ALSE FALSE FALSE
2F ALSE TRUE FALSE
5F ALSE FALSE FALSE
Note that we'd love to include a student section on our current wel
6 TRUE FALSE FALSE school

7F ALSE FALSE FALSE

8F ALSE FALSE FALSE

9F ALSE FALSE FALSE

10 F ALSE FALSE FALSE

1 1 0
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Appendix C — Source Code for EDUwebMaker

The following files may be found on the CD which our project is on. The following is the
locations where the files may be found.

Installation Files: \Source Code\EDUwebMaker
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Appendix D — Source Code for ASP2HTML

These files were taken from the Microsoft website:
http://msdn.microsoft.com/msdnmag/issues/0900/cutting/cutting0900.asp

They are public domain. They were modified in order to provide the needed features for
the program. You may find the full source code on the CD with our project on it.
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Appendix E — Data Files

The following files may be found on the CD which our project is on. The following is the
locations where the files may be found.

Installation Files: \Source Codel\install

Databases: \Source Code\EDUwebMaker
\Source Code\EDUwebMaker\Data
Data Files: \Source Code\EDUwebMaker\Data
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Appendix F — Help Files

welcome.htm:

Welcome to EDUwebMaker

Welcome. If you would like to load a project you were previously working on, go
to the File menu and select Open.

To start a new project, go to the File menu and select New. Select a location and
a name of your project. The program will create a Project File with all your
selected options. When you generate your web site, it will get placed in a sub-
directory from the location you selected.

Next, a preferences window will pop up (you get always get back to this window
later by going to the File menu and selecting Properties). On the first page you
can set basic information about the site, like the name of the project and the
name of the school.

On the second page you can select the security model for the web site. This is an
important step. One of the features of your web site will be that you can update
the content from any browser. However, to make sure unauthorized people don't
change your web site, you must set up accounts for everyone that is allowed to
edit your web site. Then you can select what pages each user can edit. Users
may also be organized into groups. For example, you could have an "admin"
account that lets you change anything, a "teachers" group containing individual
teacher names for each teacher to allow them to update their own web pages,
and a "sports" account to allow the PE teacher to update all the sports pages.
You may either select a predefined security model, or create your own. Make
sure to set passwords for each user. Note that you will be able to change the
security model later, even after you're web site it up on the internet.

Go to help contents.
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newproj.htm:

How to Set up your Web Site

Now that you've created your new project, it's time to select what's going to go
into this web site. You may want to just play around with many of the options and
try out the resulting web page before you make a final decision.

o Go to the Generator menu and select Select Features.

e You'll be presented with five pages of options:

o

Layout - Select a layout for your web site. This is the general
format of the site.

Navigation - Select a method to allow the people that visit your site
to navigate through it. These are normally different kinds of
navigation bars.

Style - Select a style to set the look and feel of your site. Styles
include the background texture, the colors of the text and links, and
text formatting.

Features - This is the big one. Select which features (content) your
web site will contain. Each of these features will turn into a separate
web page on your site.

Effects - Select any additional effects for your web site to make it
more interesting or useful. Effects will be displayed on every page.

Back to help contents.
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features.htm:

How to Generate a Web Site

Now that you've selected all the options for your web site, you need to generate
it. First, however, you should save your changes.

e Go to the File menu and select Save.
o Then, to generate the web site, go to the Generator menu and select
Generate Web Site.

Back to help contents.
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generate.htm:

How to Test the Web Site

Now that you've generated the web site, it is time to test it.

e Then, to test the web site, go to the Generator menu and select Test Web
Site.

If you don't like it or want to try something different, just go back to Select
Features, select new options, and then generate the web site again.

If you like the web site, then start adding your specific content to it. There will be
a link somewhere on your Home Page that will say something like: "Click here to
administer the web site". Click this link. You are now in the website administration
area. You may log on as any of the Users or Groups you specified before, or
"admin" (with password "admin") to login as Administrator. As Administrator, you
can do everything. You will probably want to change the password for
administrator as soon as possible. For more information on Users, Groups, and
passwords, see Administration help under the Help menu.

Once you've logged in, you may click on any of the listed web pages (features) to
insert or change the information on that page. For more information on how to
administer the web site, see the help file.

After you've entered all the information into the web site, and you're ready to get
it up on the internet, you need to find a way to "host" your site. For detailed

information on how to get your web site up on the internet, see the Hosting help
under the Help menu.

Back to help contents.
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admin.htm:

How to Administer Your Web Site

Once you have generated your web site, you may administer it. Administering
your web site involves updating the information on it, or updating the security
model. You can administer your web site while you're still testing it by going to
the Generator menu and clicking Administer Web Site.

You can also administer the web site after it has been hosted. You do this to
update the data on the web site so the web site is always up-to-date. You can do
this by clicking the link at the bottom of the home page that says administer web
page (if your home page has it). Alternatively, you can browse to /admin/ on your
web site (e.g. http://www.yourwebsite.edu/admin/).

Once you get to the initial administration page, you will be asked to log in. This is
so that other people can't hack into the site and change your web pages. You
may enter any of the username/password combinations defined in the security
model, and you will be given the permissions defined in the security model.

After this, the main administration page that gives you all your options loads.
Depending on your permissions, you can change security model settings
(add/remove groups and users, change their permissions, and change their
passwords), change your own password, or make changes to specific web
pages.

Back to help contents.
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hosting.htm:

How to Host Your Web Site

If you have generated, tested, and added all the data to your web site, then you
are ready to get it hosted. Once it is hosted, other people will be able to get to it.
You can either host the web site yourself or get a company to host it for you.

Hosting the web site yourself:

If you are planning on hosting the web site yourself, you will at minimum
need a computer that is always on and connected to the internet, that has
Microsoft IIS on it, and you'll need your own domain name. If any of that
just confused you then you need to get your school's technical person, or
you'll need to have your web site hosted by a company.

To host the site on your own computer, get the computer set up to serve
web pages, and then upload the contents of your project directory to the
root directory on the web server. The web site should display fine with the
default settings of Microsoft IIS.

Having a company host your web site:

To do this, you will need to find a web hosting company (there are many
out there) that offers you the ability to serve ASP (Active Server Pages).
They should also provide you with a domain name (e.g.
www.yourschoolname.com). Once you find the one that meets your
needs, just sign up with them and send them the contents of your project
directory. They should be able to do the rest.

Back to help contents.
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